


Pour votre sécurité

Lisez attentivement ce manuel afin d'utiliser cet appareil
correctement et d'éviter tout danger ou dommage matériel.

A AVERTISSEMENT Vous risquez de vous blesser gravement si vous ne tenez pas compte de

ces instructions.

sation de I'appareil

Ne prenez pas l'initiative de
démonter, réparer ou

) . .
’;u‘- modifier cet appareil
vous-méme.
-
Ne mouillez pas I'appareil et
ne le laissez pas tomber dans
Y I
9. Si l'appareil est mouillé, ne
v l'allumez pas. Contactez un centre

de dépannage.

Ne posez pas I'appareil dans
un endroit humide,
poussiéreux ou couvert de
suie, sous peine de
provoquer un incendie ou une
décharge électrique.

Ne laissez pas |'appareil dans
un lieu ou la température
excede 35°C (comme un
sauna ou une voiture en
stationnement par exemple).
En été, la température a l'intérieur
d'une voiture peut atteindre 80°C.
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L'utilisation prolongée de I'écouteur ou du casque
peut fortement réduire votre acuité auditive.

Si vous vous exposez a un volume sonore supérieur a 85 dB
pendant une durée prolongée, votre ouie sera
imémédiablement endommagée. Plus le son est élevé, plus
votre acuité auditive diminue (une conversation ordinaire a un
niveau sonore compris entre 50 et 60 dB alors que celui
provenant d'une route est d'environ 80 dB).

Il est fortement recommandé d'utiliser un volume sonore
moyen (le volume moyen est habituellement inférieur de 2/3
au volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus
I'écouteur ou le casque.

N'utilisez pas I'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.
Dans le cas contraire, vous risqueriez de provoguer un accident
grave. En outre, son utilisation est interdite par la loi dans
certaines régions. L'utiisation de écouteur dans la rue,
particulierement sur les passages pour piétons, pourrait
entrafner des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de
I'écouteur n’entrave pas vos mouvements ou ne

s'accroche pas dans des objets environnants lorsque

vous faites de I'exercice ou lorsque vous vous promenez.



A ATTENTIO

Lorsque vous portez
I'appareil autour du cou,
n’exercez pas de
pression excessive sur
la cordelette.

Veillez a toujours enregistrer vos
données les plus importantes.
Notez bien que nous ne saurons
étre tenus responsables en cas de
perte des données due a une
panne, & une réparation ou a toute
autre cause.

N Suivez attentivement ces instructions sous peine de provoquer des blessures
physiques ou d'endommager I'appareil.

Utilisation de I'appareil

Evitez tout impact brutal
sur |'appareil (ex. : en cas
de chute). Ne posez pas
d'objets lourds sur le
dessus de l'appareil.

Empéchez que des particules
externes ou de la poussiére
ne pénetrent dans I'appareil.

Evitez toute projection d’eau sur
I'appareil. Ne nettoyez jamais
I'appareil a 'aide de produits
chimiques (ex. : benzene ou
diluant) sous peine de provoquer
un incendie, une décharge
électrique ou une détérioration de
la surface.

Ne posez jamais I'appareil a
proximité d'objets émettant
des ondes électromagnétiques
sous peine de provoquer un
dysfonctionnement.
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Vérification de I’appareil et des accessoires i . N
Les schémas suivants sont destinés a vous

Vér|f|cat|0n deS acceSSO|reS guider et peuvent légérement différer de

I'appareil lui-méme.
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Lecteur Ecouteurs Cable USB CD d'installation Attache de ceinture

m L'aspect des accessoires est susceptible d'étre amélioré et modifié sans notification préalable.
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Vérification de I'appareil et des accessoires

Composants

| Face avant, coté droit et dessus de I’appareil

> Port de connexion des écouteurs

» Bouton USER/MENU

» Bouton d'alimentation et de lecture/pause

» Ecran d'affichage

» Bouton de changement de plages/
recherche rapide




| Face arriére
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» Trou de réinitialisation
» Fiche USB

» Bouton de réglage du volume

» Interrupteur Hold

Branchement des ECoUteUrs Tirrrrrrrrr sy e prssa

» Haut
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Vérification de I'appareil et des accessoires

Affichage des informations a |'écran

| Musique

R S A

b 0009/0020 MEIEIR A+g @1

Témoin de lecture/pause/arrét

Témoin Numéro de la plage en cours/
nombre de plages total

Singer - Song1 —1—6 3 Témoin du mode Sound (Son)
@€ 00:00:20 4 Témoin du mode Play (Lecture)
é é 5 Témoin de I'état de la batterie
6 Témoin du titre de la plage en cours
7 Barre d'état de la lecture
8 Témoin du temps de lecture
| Radio FM
(] (2] © 1 Témoin de réception FM
l l l 2 Témoin du numéro de la station
FM:: PRESET il @ERYCID @
3 Témoin des modes Mono/Stéréo
100.00 MHz —0 . .
LY \ 4 Témoin de la fréquence
5 Témoin de position de fréquence

e



Vérification de I’appareil et des accessoires

Fonctions des boutons

@ O USER
© MENU

)
O

= Appuyez longuement sur le bouton pour allumer ou éteindre I'appareil.
m Appuyez briévement sur le bouton pour sélectionner Lecture/Pause.

= Appuyez longuement sur le bouton pour accéder a ['écran de menu.
m Appuyez briévement sur le bouton pour utiiser les fonctions de réglage USER — Navigation/ Repeat
AB (Répétition AB)DNSe (Egaliseur)/Play Speed (Vitesse de lecture)/Play Mode (Mode de lecture)

m Appuyez longuement sur le bouton effectuer un balayage rapide des plages.
= Appuyez briévement sur le bouton pour sélectionner la plage précédente ou lire
la plage en cours & partir du début.

m Appuyez longuement sur le bouton effectuer un balayage rapide des plages.

= Appuyez brievement sur le bouton pour passer a la plage suivante.

m Appuyez brievement sur le bouton pour augmenter le volume ou
pour accéder a I'élément / au menu supérieur.

= Appuyez brievement sur le bouton pour diminuer le volume ou
pour accéder a I'élément / au menu inférieur.

m Poussez I'interrupteur dans le sens de la fleche pour verrouiller
les fonctions des boutons.

= Appuyez sur le bouton a I'aide d'un objet pointu pour réinitialiser
le systeme.
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H Chargez la batterie complétement avant d'utiliser le
Ch arg em ent d e | a b atte” e lecteur pour la premiére fois ou lorsqu'il n'a pas été

utilisé depuis longtemps.

Affichage a I'écran
u Chargement en cours...

n Chargement terminé

1 Otez le capuchon USB situé sous le corps de I'appareil.
2 Branchez le cable USB sur le port USB ( "II ) de votre ordinateur.

3 Branchez I'autre extrémité du cable USB sur le fiche USB situé dans la partie
inférieure du lecteur.

m Le temps nécessaire & un chargement complet est d'environ deux heures et demie ; il peut
néanmoins varier en fonction de I'environnement installé sur l'ordinateur.

| utilisation de la batterie

n Rechargez et rangez l'appareil dans un lieu ot la température est comprise entre 5 et 35°C.

m Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger la batterie a des fréquences trop
rapprochées peut réduire sa durée de vie.

= Comme pour tout autre produit de consommation, la durée de vie de la batterie raccourcit progressivement avec le temps.

m La connexion USB peut s'avérer instable si vous utilisez un concentrateur USB. Reliez directement la batterie au
port USB de votre ordinateur.



Utilisation de base

| Mise sous et hors tension de 'appareil

» 0009 /0020 NoR, ]| Mise sous tension de I'appareil
Singer — Song 1 Appuyez longuement sur le bouton [ »1].
€ 00:00:20 n L'appareil s'allume.

Mise hors tension de I'appareil

Appuyez longuement sur le bouton [ »1].
n L'appareil s'éteint.
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m |'appareil s'éteint automatiquement lorsque aucun des boutons n'est utilisé pendant une durée
FelRUE  prédéfinie (par défaut : 10 secondes) en mode Pause (Pause). > Page 49

| Lire des fichiers musicaux

.n, r ‘l o) 1 Appuyez longuement sur le bouton [ ® USER /& MENU]
96 ¢ pour accéder a I'écran de menu.

Music

2 Appuyez sur le bouton [ +, -] pour sélectionner
<Music> (Musique).

3 Appuyez sur le bouton [ ® USER/e® MENU].
n Lalecture démarre.

aseq ap uolesijin/alialeq | ap Juswabieyd



Utilisation de base (suite)

| Réglage du volume

b 0009/00Z0 BCEm NoR_@mm|  Appuyez sur le bouton [ +, -] situé sur le c6té du

. lecteur.
Singer — Song 1 ecteur

y » La barre d'état du volume s'affiche.
a0 m Appuyez sur le bouton [ +] pour augmenter le volume ou

sur le bouton [ —] pour le diminuer.

| Fonction Lock (Verrouillage)

En mode Hold, tous les boutons sont désactivés. Vous
apprécierez particulierement le c6té pratique de cette
a fonction lors de vos marches ou de vos courses a pied.

1 Poussez l'interrupteur [HOLD] du lecteur dans le
sens de la fléche.

2 Poussez l'interrupteur [HOLD] dans le sens opposé
a celui indiqué par la fleche pour désactiver la
fonction Lock (Verrouillage).

14



| Recherche de fichiers via la fonction <Navigation>

Recherchez des fichiers en toute simplicité grace la fonction <Navigation>.

- @D -

Navigation

1 Appuyez longuement sur le bouton [ ® USER/«® MENU]
pour accéder a I’écran de menu.

Appuyez sur le bouton [ +, -] pour sélectionner
<Music> (Musique).

3 Appuyez sur le bouton [ ® USER/e® MENU].
n La liste des dossiers <Navigation> s'affiche.

Appuyez sur le bouton [ +, - ] pour sélectionner le
dossier de votre choix.

5 Utilisez le bouton [»»] pour accéder a la liste des
fichiers dans le dossier sélectionné.

n Utilisez le bouton [PP] pour accédez au niveau inférieur
et sur le bouton [I4«] pour accéder au niveau supérieur.

Appuyez sur le bouton [+, - ] pour sélectionner le
fichier de votre choix.

7 Appuyez sur le bouton [ »11].
m La lecture du fichier sélectionné démarre.
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Utilisation de base (suite)

| Fonction Reset (Réinitialisation)

Si un dysfonctionnement de I'appareil
survient, vous pouvez réinitialiser le
systéme en appuyant sur le trou de
réinitialisation. » Page 55




Importation de fichiers musicaux......... 18
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Ajout de fichiers / dossiers dans Media
Studio via AUtOSCaN............coevvececirecicines 24

Transfert de fichiers via Media Studio........ 26
Utilisation du lecteur en tant que disque

AMOVIDIE ... 28
Débrancher I'appareil de l'ordinateur......... 29



18

Importation de fichiers musicaux

Transfert de fichiers musicaux

Pour lire des fichiers musicaux, commencez par transférer les fichiers au format

MP3, WMA, Audio ASF, Ogg et autres formats compatibles depuis votre ordinateur
sur le lecteur MP3.

Suivez les étapes ci-dessous pour transférer des fichiers.

Transfert de fichiers musicaux

» Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant Media Studio
» Page 26

= Transfert de fichiers depuis votre ordinateur sur le lecteur en utilisant les fonctions
«Copier» et «Coller» (disque amovible) » Page 28



Importation de fichiers musicaux
H H H Utilisez Media Studio pour transférer des
In Stal | atl 0 n d e Med Ia Stu d I 0 fichiers musicaux de votre ordinateur vers le

lecteur.

Si Media Studio ne s'installe pas automatiquement

m Installez le programme sur un ordinateur fonctionnant sous Windows 2000 ou Windows XP aprés vous
étre connecté en tant qu'administrateur. Veuillez vous reporter au manuel d'utilisation de I'ordinateur
pour savoir comment vous connecter en tant qu'administrateur.

ATTENTION

Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

IO Samsung Digita 1 Cliquez sur <Install now>
= (Installer maintenant).

User Manual

UNG. Al Rights Reserved.

«0IpNIS BIPSIA» 9p UOIe|elSU|
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Importation de fichiers musicaux

Installation de Media Studio (suite)

SEmEunEed st oo

Start Copying Files
Review setngs before copingfes.

The selup rogram satscopying proga s usingth folowing nformation.
Clck [CSTaM o e

i e unent setngs.

Curert Seltings:

Insallton Type 1

Instalaton Infomatin
Folde 1a st CA\Program Fles\SameunglSaeunghledisStudiod 1
Frogian Folde S amsurgecastuod 1

Gracenote Tems of Uss.
Thissppicaton cotains softwae o Gracencl

cusToM

Caen

SamsunghediaStudo Setup s prorming the equested operaions.

Insling
CAProgin Fles\Samsung\SamsunghedaStudod 1\Am(2052)cab.

26%

2 Cliquez sur <NEXT> (SUIVANT).
» L'installation de Media Studio démarre.

3 Une fois l'installation a jour terminée, cliquez
sur <Exit> (Quitter).
» Une fois l'installation terminée, une icone apparait
sur le bureau et Media Studio démarre.
n Si la fenétre de confirmation d'Autoscan apparait,
reportez-vous a la page 25 pour personnaliser les
réglages.



Importation de fichiers musicaux

Branchement de I'appareil sur votre ordinateur

1 Otez le capuchon USB situé sous le corps de I'appareil.
2 Branchez le cable USB sur le port USB ( ‘1/ ) de votre ordinateur.

3 Branchez I'autre extrémité du cable USB sur le fiche USB situé dans la partie
inférieure du lecteur.

| Configuration requise

Vous pouvez brancher I'appareil sur votre ordinateur si celui-ci est équipé des
composants suivants:

» Pentium 300 MHz ou version ultérieure » Lecteur de CD-Rom (2X ou plus)
= Windows 98SE/ME/2000/XP = Port USB 2.0
= 100 Mo d'espace libre sur le disque dur = DirectX 9.0 ou version ultérieure
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Importation de fichiers musicaux

Ajout de fichiers / dossiers dans Media Studio

Samsung Modia Studio =~

Musicis My Life

ife
Samsung Media Studio

it B Q' MP3 Player  Virlsl Device
s
= e (® What is Library?
= (1 My Folder
Libran feature that enables you to easily save and manage media files e il
T—
b Add FOIDE | 206 etc and youcan manase 5 e s O 72
3| sadrie
» ow Paing oM IR0)

Veuillez vous reporter a la section Aide pour obtenir plus d'informations sur
I'utilisation de Media Studio.

n Cliquez sur <MENU> (MENU) — <Help> (Aide) — <Help> (Aide) dans le menu situé en haut du
programme Media Studio ou appuyez sur la touche F1 de votre clavier durant la lecture

m Les fichiers qui ont déja été ajoutés a la bibliothéque ne seront plus ajoutés.




m Branchez le lecteur sur I'ordinateur.
» Media Studio doit étre installé sur l'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.
» Si le programme ne démarre pas automatiquement, double-cliquez sur l'icone Media Studio située
sur le bureau.
2 Cliquez sur I'onglet <Media Library> (Bibliotheque Media) — <Library>
(Bibliotheque) situé a gauche de la fenétre Media Studio.

n Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>
(Balayage automatique) s‘affichent.
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| Pour ajouter des fichiers

3 Cliquez sur <Add File> (Ajouter un fichier).
u La fenétre Open (Ouvrir) apparait.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).
m Les fichiers sélectionnés sont ajoutés a la liste.

Browse for Folder (@[]

Select a folder,

| Pour ajouter des dossiers N
153 ry Documents
& -

3% Floppy (A1)
Local Disk (C:)

3 Cliquez sur <Add Folder> (Ajouter un dossier).
n La fenétre Browse Folder (Parcourir les dossiers) apparait.

CO-RiW Drive (F:)
Removable Disk (G:)

«0IPMS RIPAN» SUBP SIBISSOP / SIaIYa1) ap 1oly

4 Sélectionnez les dossiers que vous souhaitez ajouter
et cliquez sur <OK>.

m Les dossiers sélectionnés sont ajoutés a la liste.

N
w
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Importation de fichiers musicaux

Ajout de fichiers / dossiers dans Media Studio via Autoscan

Ve S Tel=lal%

Samsung Media Studio

Hide: Quick Button

Media Library > Liay At -] ‘w3 piayer virual beviee @]

» Media Library,

= [ ubrary
il Music
W Video
@ Photo
& o (® what is Library?
@ (3 My Folder
Library is a feature that enables you to easily save and manage media files MR S
an your computer, [ VOICE

21 Beethoven's Sympho... 599...
Library consists of Music. Video. Photo and Etc and vou can manage 3| Mew Stories (Highwa.., 742...
the correspanding contents using each menu,

4| markany.mp3 14.6..

£dd File Add Foldet

+ Now Playing o @ @




m Branchez le lecteur sur I'ordinateur.
» Media Studio doit étre installé sur I'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.

» Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone Media Studio située
sur le bureau.

2 Cliquez sur I'onglet <Media Library> (Bibliotheque Media) — <Library>

(Bibliotheque) situé a gauche de la fenétre Media Studio.

m Les éléments <Add File> (Ajouter un fichier)/<Add Folder> (Ajouter un dossier)/<Auto Scan>
(Balayage automatique) s‘affichent.
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3 Cliquez sur <Auto Scan> (Balayage automatique).
» La fenétre Autoscan (Balayage automatique) apparait.

Auto Sean searches for media s n your PC and make them
a3t The users
can manage the found fes using

SomsingMedo Sudo Ly,
4 Cliquez sur <OK> (OK). i
n Le balayage des fichiers s'effectue automatiquement et les
fichiers sont ajoutés a la bibliothéque.

m Lors de votre premiére utilisation de Media Studio, les fenétres
Autoscan Confirm (Confirmation d'Autosccan) et Options
(Options) apparaissent selon le cas. Réglez les options puis @ s *
cliquez sur <OK> (OK) pour lancer Autoscan. Gonara | Loy |Gt | [ GO

Réglage des options d'Autoscan

Click <MENU> (MENU) — <Tools> (Outils) — <Environment

Settings> (Configuration de I'environnement) en haut de la - P

fenétre Media Studio, puis cliquez sur l'onglet <Library> o

(Bibliotheque).

m Sélectionnez.la gamme et le type de fichier pour lequel vous
souhaitez effectuer un balayage automatique.

UBISOINY BIA 0IPNIS

RIPS\ SUBP SISISSOP / SIaIYd1) ap INoly

B Downlood Folder Setting
Sets kder 0 savefesdonrloaded o e sre and convered by e
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Musks [ Dacmert e Change
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& AddtoMowPiyinglt and play




Importation de fichiers musicaux

Transfert de fichiers via Media Studio

Samsung Media Studio

intro.wmy

wmA Highway Blues”
markany.mpa

5

Q it

0/4 | D00MB/333MB
» Now Playing

wmn Symphony Mo, 3 (Scherzo)

wme Yindows Welcome music

Title File Name

Besthaver's Symphony No, 5 (Sche . |
Nlew Stories (Highway Blues) wma
matkarty mp3

ttle.wma

File Name Siee
YOICE

6 (- a issthoven's Sympho... 599....

lews Stories (Highwa... 742,

markany.mp3 14.6.

Device Connection 2
window

ONISIG

REVARQU

= La technologie de reconnaissance musicale et les données relatives sont fournies par Gracenote
et Gracenote CDDBR Music Recognition Service®.

= CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo et le
logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des marques
déposées de Gracenote. Music Recognition Service et MRS sont des marques de service de

Gracenote.
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» Branchez le lecteur sur l'ordinateur.
» Media Studio doit étre installé sur l'ordinateur.

o 0~ WO DN

Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.

n Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone Media Studio située
sur le bureau.

Double-cliquez sur le dossier de votre choix dans la fenétre Device Connection
(Connexion de I'appareil) a droite de la fenétre Media Studio.
m Les fichiers contenus dans le dossier s'affichent.

Cliquez sur I'onglet <Media Library> (Bibliothéque Media) situé a gauche de la
fenétre Media Studio.

Cliquez sur <Music> (Musique).
m Une liste de fichiers s'affiche dans la fenétre centrale.

Cochez les fichiers musicaux a transférer dans la liste de la fenétre centrale.
m L'icone Transmit (Transmettre) apparait.

Cliquez sur <Transmit> (Transmettre).
m Les fichiers sélectionnés sont transférés vers le lecteur.

n Ne débranchez pas la cable USB durant le transfert sous peine d'endommager le lecteur ou
l'ordinateur.

ATTENTION

Re!

.
. = Les fichiers ne sont pas supprimés de l'ordinateur méme s'ils sont transférés vers le lecteur.
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Utilisation du lecteur en tant que disque amovible

Vous pouvez utiliser le lecteur comme appareil de stockage de données amovible.

= Branchez le lecteur sur l'ordinateur.

1 Ouvrez les fichiers/dossiers a transférer a
partir de I'ordinateur.

2 Cliquez sur <My Computer> (Poste de
travail) —» <Removable Disk> (Disque
amovible) & partir du bureau.

3 Sélectionnez les fichiers/dossiers que
vous souhaitez transférer depuis votre
ordinateur et faites un cliquer-glisser vers
le dossier de votre choix dans
<Removable Disk> (Disque amovible).

m Les dossiers ou fichiers sélectionnés sont
transférés vers le lecteur.

Le message <USB Transferring> (Transfert USB) s'affiche durant le transfert. Débrancher la cable USB
tant que le message <USB Transferring> (Transfert USB) est affiché peut entrainer un dysfonctionnement
de I'appareil.

L'ordre dans lequel les fichiers musicaux sont affichés dans I'explorateur Windows peut étre différent de
l'ordre de lecture de I'appareil.

Si vous transférez un fichier DRM (fichier chargé) vers le disque amovible, le fichier ne sera pas lu.

ATTENTION

Sélectionnez le fichier que vous souhaitez enregistrer et faites un cliquer-glisser sur licone du disque
amovible. Si vous changez le nom des fichiers musicaux (qui apparaissent dans I'ordre numérique,
alphabétique) dans I'explorateur Windows (ex. : 001* * ¥ 002* * *...), les fichiers musicaux sont lus
dans l'ordre des numéros indiqué.

= Qu'est-ce que les DRM ?

La technologie et le service DRM (Gestion des droits numériques) permettent d'éviter l'utilisation illégale de
données numériques et de protéger les détenteurs de droits d'auteur. Les fichiers DRM sont des fichiers
musicaux chargés pour lesquels s'applique la technologie de protection concernant les copies illégales de
fichiers musicaux MP3 obtenus de facon Iégale.



ATTENTION

Debrancher 'appareil de I'ordinateur

Suivez les étapes ci-dessous pour éviter d'endommager I'appareil et les données au moment du

débranchement.

[Safely remove LUSE Mass Storage Device - Drive

|

V

1 Positionnez le curseur de la souris sur

licéne & située sur la barre des
taches en bas a droite du bureau et
cliquez sur le bouton gauche de la
souris.

Cliquez sur le message <Safely
Remove USB Mass Storage Device
Drive> (Retirer en toute sécurité le
lecteur USB grande capacité).

m Apres avoir cliqué sur < Safely Remove
USB Mass Storage Device Drive>
(Retirer en toute sécurité le lecteur USB
grande capacité), I'appareil ne pourra pas
étre rechargé méme s'il est connecté a
l'ordinateur.

3 Débranchez le lecteur de I'ordinateur.

n Ne débranchez pas le lecteur de l'ordinateur durant le transfert. Les données ou l'appareil

risqueraient d'étre endommagés.

= Vous ne pouvez pas retirer le matériel pendant que des fichiers contenus dans le lecteur sont lus
sur l'ordinateur. Veuillez réessayer une fois la lecture des fichiers terminée.
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Ecouter de la musique...........ccccccevuerennee 31
Ecouter de la musique............cccccovvicinins 31
Fonction de personnalisation du bouton

Ecouter laradio FM...
Ecouter la radio FM
Réglage d'une fréquence
Pour supprimer les préréglages ...
Réglage de la radio FM

= Avant de démarrer!

Transférez le fichier musical de votre choix depuis I'ordinateur vers le lecteur.




Ecouter de la musique

Ecouter de la musique

Branchez les écouteurs sur le lecteur, mettez I'appareil sous tension et vérifiez
I'état de la batterie.

» 0003 /0020 NOR,. (umn 1 Appuyez longuement sur le bouton [ @ USER/ @ MENU]
Singer — Song 1 pour accéder a I'écran de menu.

€ 00:00:20 2 Appuyez sur le bouton [ +, -] pour sélectionner
<Music> (Musique).

3 Appuyez sur le bouton [ @ USER/ @ MENU].
m Lalecture de musique démarre.

m Les fichiers musicaux compatibles avec le lecteur sont aux
. formats MP3, WMA, Ogg et Audio ASF
" m Les fichiers MP1 ou MP2 possédant uniquement une
extension modifiée vers MP3 peuvent ne pas étre lus.

| Mode Pause (Pause)

11 0009 /0020 METREEE NOR. {mm 1 Appuyez sur le bouton [ »11] lorsque la lecture de

. la musique est en cours.
Singer — Song 1 q . )
m La lecture de la musique est interrompue.

@€ 00:00: i
00:00:20 Appuyez sur le bouton [ p-n1] une nouvelle fois.

m La lecture reprend a I'endroit ou vous l'avez suspendue.

m L'appareil s'éteint automatiqguement lorsque aucun des
boutons n'est actionné pendant une durée prédéfinie (par
défaut : 10 secondes) en mode Pause (Pause). » Page 49
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Ecouter de la musique

Ecouter de la musique (suite)

| Pour effectuer une recherche a l'intérieur d'une plage

1 Appuyez longuement sur le bouton [ I44]ou [ »P] pendant que la plage
sélectionnée est en cours de lecture.

n Ces boutons permettent d'effectuer la recherche vers le début ou la fin de la plage.
2 Relachez le bouton des que vous souhaitez reprendre la lecture.

m La lecture reprend au point ot vous avez relaché le bouton.

| Lecture de la plage en cours a partir du début

Appuyez sur le bouton [ |44] aprés 5 secondes de lecture.
» La plage en cours est lue a partir du début.

| Lecture de la plage précédente/suivante

Appuyez sur le bouton [ |44] dans les 5 premieres secondes de lecture.
» La lecture de la plage précédente démarre.

Appuyez sur le bouton [ PP ].

m La lecture de la plage suivante démarre.

m Pendant la lecture de fichiers VBR, la plage précédente peut ne pas étre lue méme si vous appuyez
ATENTON sur le bouton [ 144] dans les 5 premiéres secondes de lecture.

- m Appuyez sur le bouton [ |4« ] dans les 5 premiéres secondes de lecture pour passer a la plage
Qe Précédente.




Ecouter de la musique

Fonction de personnalisation du bouton User

Pour plus de commodité, personnalisez les boutons avec les fonctions les plus souvent utilisées.

| Pour définir le mode du bouton User

a1 Pour effectuer un changement de mode simple, utilisez

o Navigation >
g2 le bouton [ ® USER/@® MENU] pendant la lecture.

® Repeat AB
o DNSe >y 1 Appuyez longuement sur le bouton [ @ USER/ e MENU]

pour accéder a I'écran de menu.

2 Appuyez sur le bouton [ +, -] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[ ® USER/ @ MENU].

= Le menu Settings (Réglages) apparait.
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3 Appuyez sur le bouton [ +, -] pour sélectionner
<User Button Mode> (Mode du bouton User),
puis appuyez sur le bouton [ ® USER/ @ MENU].
w Le menu User Button Mode (Mode du bouton User) apparait.

4 Appuyez sur le bouton [ +, -] pour sélectionner le
mode du bouton User de votre choix, puis appuyez
sur le bouton [ ® USER/@® MENU].

= <Navigation> : Vous pouvez définir 'affichage de la liste des fichiers de navigation
m <Repeat AB> (Répéter AB) : permet de régler la répétition d’'un segment.

m <DNSe> (Egaliseur) : permet de sélectionner le mode sonore.
L
L ]
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<Play Speed> (Vitesse de lecture) : permet de choisir une vitesse de lecture (rapide ou lente).
<Play Mode> (Mode de lecture) : permet de sélectionner le mode de répétition de la lecture
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Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

| Pour créer votre propre liste de lecture

Vous pouvez facilement écouter votre musique préférée

1 — |
2 Singer - Song 1> en I'ajoutant a une liste de lecture.

* Singer - Song2 >
J Singer - Song3 > 1 Réglez le mode du bouton User sur <Navigation>.

2 Appuyez sur le bouton [ @ USER/@® MENU]
lorsque la lecture de la musique est en cours.

n La liste des fichiers figurant dans le dossier apparait.

3 Appuyez sur le bouton [ |44, »P|, +, -] pour
ajouter des fichiers a la liste de lecture, puis
appuyez sur le bouton [ @ USER/ @ MENU] .

» % s'affiche devant les fichiers sélectionnés qui sont
ensuite ajoutés a la liste de lecture.

m Pour supprimer des fichiers de la liste de lecture, sélectionnez les # fichiers a supprimer, puis appuyez
RERQE @ nouveau sur le bouton [ @ USER/ @ MENU].




| Pour lire une liste de lecture

Ko fol 1 Appuyez longuement sur le bouton [ ® USER/@® MENU]

. pour accéder a l'écran de menu.
Playlist

2 Appuyez sur le bouton [ +, -] pour sélectionner
<Playlist> (Liste de lecture), puis appuyez sur le
bouton [ @ USER/@® MENU].

n La liste de lecture spécifiée s'affiche.
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3 Appuyez sur le bouton [ +, -] pour sélectionner
la liste que vous souhaitez lire, puis appuyez
sur le bouton [ »11].

» La lecture des fichiers contenus dans la liste
de lecture démarre.

Jasn uownoq

np uoifesifeuuosiad ap uonauoH



Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

| Pour rechercher la musique de votre choix a I'aide de la fonction Navigation

4 Singer - Song1 > fi 1 Réglez le mode du bouton User sur <Navigation>.

#Singer —Song2 >
+Singer - Song3 > 2 Appuyez sur le bouton [ @ USER/ @ MENU]

lorsque la lecture de la musique sélectionnée est en
cours.

n La liste des fichiers figurant dans le dossier apparait.

3 Appuyez sur le bouton [ |4«] pour accéder au
dossier précédent.

Appuyez sur le bouton [ +, -] pour sélectionner le
dossier de votre choix.

5 Utilisez le bouton [ PP ] pour accéder a laliste de
fichiers dans le dossier sélectionné.

n Utilisez le bouton [ »P] pour accéder au niveau inférieur
et sur le bouton [ |4« ] pour accéder au niveau supérieur.

6 Appuyez sur le bouton [ +, - ] pour sélectionner
le fichier de votre choix.

7 Appuyez sur le bouton [ »11] .
m La lecture du fichier sélectionné démarre.



| Pour définir la répétition d’'un segment

» [009/0020 ECTEE R+ g (@D
Singer — Song 1
@ 00:00:20

Cette fonction vous permet d'écouter des parties
spécifiques d'une plage d'une fagon répétée.
Recommandée pour |'apprentissage d'une langue.

1 Réglez le mode du bouton User sur <Repeat AB>

(Répéter AB) et lancez la lecture du fichier de votre
choix.

2 Appuyez sur le bouton [ @ USER/@® MENU] au
début du segment que vous souhaitez répéter

m Le début est défini et <A — > apparait sur 'écran d'affichage.

3 Appuyez sur le bouton [ @ USER/@® MENU] pour
définir la fin du segment que vous souhaitez
répéter.

» <A-— B> s'affiche a I'écran et la lecture répétée de la
section spécifiée démarre.

| Pour annuler la répétition du segment

Appuyez sur le bouton [® USER/@® MENU] pendant la répétition du segment.
n La répétition du segment est annulée.

m La répétition du segment s’annule automatiquement dans les cas suivants :

cours ne se termine.

- lorsque le bouton [I«4<] ou [>P] est actionné pour aller a la plage précédente ou suivante ;
- lorsque le début du segment a répéter est défini mais que la fin ne I'est pas avant que la plage en
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Ecouter de la musique

Fonction de personnalisation du bouton User (suite)

| Pour utiliser le bouton DNSe (Egaliseur)

Réglez le mode du bouton User sur <DNSe> (Egaliseur) et appuyez sur le bouton

[® USER/ @ MENU].

» Chaque fois que vous appuyez sur le bouton, les options du mode DNSe (Egaliseur) défilent dans
I'ordre suivant : <XNORMAL> (NORMAL) <ROCK> (ROCK) <HOUSE> (HOUSE) <JAZZ> (JAZZ)
<DANCE> (DANCE) <BALLAD> (BALLADE) <R&B> (R&B) <CLASSICAL> (CLASSIQUE)
<USER EQ> (EGALISEUR PERSONNALISE) <3D USER> (PERSONNALISE 3D) <3D STUDIO>
(STUDIO 3D) <3D STAGE> (PLATEAU 3D) <3D CLUB> (CLUB 3D).

| Pour utiliser le bouton de vitesse de lecture

Réglez le mode du bouton User sur <Play Speed> (Vitesse de lecture) et appuyez sur le
bouton [ ® USER/e® MENU].

» Chaque fois que vous appuyez sur le bouton, les options du menu Vitesse de lecture défilent dans
l'ordre suivant : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> <x1.3>.

| Pour utiliser le bouton du mode de lecture

Réglez le mode du bouton User sur <Play Mode> (Mode de lecture) et appuyez sur le
bouton [® USER/ & MENU].

» Chaque fois que vous appuyez sur le bouton, les options du mode de lecture défilent dans
I'ordre suivant : <Normal> (Normal) <Repeat One> (Répéter une) <Repeat All> (Répéter tout)
<Shuffle All> (Lecture aléatoire de la totalité).



Ecouter la radio FM

Ecouter la radio FM

Branchez les écouteurs sur le lecteur, mettez I'appareil sous tension et

vérifiez I'état de la batterie.

FM Radio

1 Appuyez longuement sur le bouton
[® USER/@® MENU] pour accéder a I'écran de menu.

Appuyez sur le bouton [ +, -] pour sélectionner

<FM Radio>(Radio FM), puis appuyez sur le bouton
[® USER/@® MENU].
n La réception de la radio FM est activée.

| Pour rechercher automatiquement les fréquences

FMs scAN [ _Mono |
100.00 MHz

Appuyez sur le bouton [ ® USER/e® MENU] et
sélectionnez <Manual Mode> (Mode manuel).

m Le message <PRESET> (PREREGLAGE) disparait de I'écran

et l'appareil passe en mode manuel.

2 Appuyez longuement sur le bouton [ I44] ou [ »P],
puis relachez-le.
» La fréquence la plus proche du point ou le bouton est

relaché est recherchée.

| Pour rechercher manuellement les fréquences

FM: [_MoNo |

100.00 MHz
BBC R2

1 Appuyez sur le bouton [ ® USER/e@® MENU] et
sélectionnez <Manual Mode> (Mode manuel).

= Le message <PRESET> (PREREGLAGE) disparait de I'écran

et l'appareil passe en mode manuel.

2 Appuyez sur le bouton [ |4«4] ou [ PP].
» Change de fréquence a chaque nouvelle pression du bouton.
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Ecouter la radio FM

Réglage dlune fréquence gnnremg?:tirmé-um de 20 fréquences peut étre

| Pour régler automatiquement les fréquences

FMs> auTo [_MONo (11| 1 Appuyez longuement sur le bouton
100.00 MHz [® USER/@® MENU] pour accéder a I'écran de menu.

e 2 Appuyez sur le bouton [ +, - ] pour sélectionner

<Settings> (Réglages), puis appuyez sur le bouton
[® USER/@® MENU].

» Le menu Settings (Réglages) apparait.

w Pour régler a nouveau la fonction 3 Appuyez sur le bouton [ +, -] pour sélectionner

<huto Preset> (Préréglage <FM Radio> (Radio FM), puis appuyez sur le
automatique) apres la

configuration du préréglage, les bouton [® USER/ e MENU].

fréquences existantes sont toutes » Le menu FM Radio (Radio FM) apparait.

supprimées et vous pouvez alors

procéder a une opération de 4 Appuyez sur le bouton [ +, -] pour sélectionner

€initialisation depuis le début. oz . .
fenialsaton depu . <Auto Preset> (Préréglage automatique), puis

appuyez sur le bouton [ ® USER/e® MENU].

Branchez toujours vos . ) . - . N
- ! n La fenétre de confirmation du préréglage automatique apparait.

[TTaoy €couteurs au lecteur lorsque
vous recherchez ou réglez , .
les fréquences. 5 Appuyez sur le bouton [ +, -] pour sélectionner <Yes>
Les écouteurs sont utlisés (Oui), puis appuyez sur le bouton [ ® USER/ @ MENU].
ZZ??:d:QIE&nES de réception m Le message <AUTO> (AUTOMATIQUE) apparait et les

fréquences sont réglées automatiquement entre 1 et 20 .

| Pour annuler une opération pendant le réglage

Pour annuler une opération durant le réglage de la fonction <Auto Preset> (Préréglage
automatique), appuyez sur le bouton [ 144] ou [ »PI].
» Le préréglage automatique est annulé et les fréquences réglées jusque-la sont enregistrées.



| Pour régler manuellement les fréquences

FM:: L fono | 1 Appuyez sur le bouton [ ® USER/ @ MENU] et
100.00 MHz sélectionnez <Manual Mode> (Mode manuel).
Save ? > n Le message <PRESET> (PREREGLAGE) disparait de
I'écran et 'appareil passe en mode manuel.

2 Appuyez sur le bouton [ |4<€] ou [ »PI] pour
rechercher les fréquences a définir dans le
préréglage.

3 Appuyez sur le bouton [ »m].
m Le message <Save?> (ENREGISTRER ?) apparait.

4 Appuyez sur le bouton [ I4«] ou [ »P] pour
spécifier les numéros, puis appuyez sur le bouton
[® USER/@® MENU].

» Le message <SAVED!!> (ENREGISTRE !!) s'affiche et la
fréquence sélectionnée est attribuée au numéro de
préréglage spécifié.

| Pour rechercher les fréquences en mode PRESET (PREREGLAGE)
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FM: PRESET B GLIICHD 5] 1 Appuyez sur le bouton [ ® USER/e® MENU] et
100.00 MHz sélectionnez <Preset Mode> (Mode préréglage).

BBC R2 m Le message <PRESET> (PREREGLAGE) apparait a
I'écran et I'appareil passe en mode de préréglage.

9ouanbaly aun,p abe|bay

2 Appuyez sur le bouton [ |4«4] ou [ »P].

m Le numéro préréglé est sélectionné ; vous pouvez alors
écouter la fréquence radio attribuée a ce numéro.

41
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Ecouter la radio FM

Pour supprimer les préréglages

= Suivez les étapes suivantes pour supprimer les fréquences tout en
écoutant la radio FM.

FM: [_+oNo R}

100.00 MHz
Delete?

Y] N

1 Appuyez sur le bouton [ ® USER/ @® MENU] et

sélectionnez <Preset Mode> (Mode préréglage).

» Le message <PRESET> (PREREGLAGE) apparait a I'écran
et l'appareil passe en mode de préréglage.

Appuyez sur le bouton [ |44] ou [ »P] pour
rechercher les fréquences a supprimer dans le
préréglage.

Appuyez sur le bouton [ »11].
» Le message <Delete? (Supprimer ?)> apparait.

Appuyez sur le bouton [ |4«] ou [ »PI] pour

sélectionner <Y> (O), puis appuyez sur le bouton

[® USER/@® MENU].

m Le message <DELETED!!> (SUPPRIME !!) apparait et le
numéro préréglé sélectionné est supprimé.

= Pour annuler la suppression du numéro préréglé,
sélectionnez <N> (N).



Ecouter la radio FM

Réglage de laradio FM

| Pour régler larégion FM

1
o Japan
o Other Countries 2

3

5

Appuyez longuement sur le bouton

[® USER/ @ MENU] pour accéder a I'écran de menu.

Appuyez sur le bouton [ +, -] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[® USER/ @ MENU].

= Le menu Settings (Réglages) apparait.

Appuyez sur le bouton [ +, -] pour sélectionner
<FM Radio> (Radio FM), puis appuyez sur le bouton
[® USER/@® MENU].

= Le menu FM Radio (Radio FM) apparait.

Appuyez sur le bouton [ +, -] pour sélectionner
<FM Region> (Région FM), puis appuyez sur le
bouton [ ® USER/&® MENU].

= Le menu FM Region (Région FM) apparait.

Appuyez sur le bouton [ +, -] pour sélectionner la région
FM, puis appuyez sur le bouton [ ® USER/ @® MENU].

= Vous pouvez choisir entre <Korea/USA> (Corée/Etats-Unis)
<Japan> (Japon) ou <Other Countries> (Autre pays).

Bande de fréquences par région

- Corée/Etats-Unis : recherchez des fréquences FM comprises entre 87,5 MHz et 108 MHz pour les
lecteurs de 100 kHz.

- Japon : recherchez des fréquences FM comprises entre 76,0 MHz et 108 MHz pour les lecteurs de 100 kHz.
- Autres pays : recherchez des fréquences FM comprises entre 87,50 MHz et 108 MHz pour les lecteurs de 50 kHz.

m La région FM peut étre supprimée ou modifiée en fonction de la région cible du lecteur.

m Si vous modifiez la région FM, les fréquences radio préalablement enregistrées seront supprimées.

«Q
=4
&
5
|
L
&
=
=
=
S
=
=
e
3
B
=
el
=8
S

N4 olpel e| ap abe|boy

/sabe|Balaid sa| Jawiiddns Inod

N
w



Ecouter la radio FM

Réglage de laradio FM (suite)

| Pour régler la réception FM

1 Appuyez longuement sur le bouton

o Middle [® USER/@® MENU] pour accéder a I'écran de menu.

oLow 2 Appuyez sur le bouton [ +, -] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[® USER/ @ MENU].

» Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner
<FM Radio> (Radio FM), puis appuyez sur le bouton
[® USER/@® MENU].

m Le menu FM Radio (Radio FM) apparait.

4 Appuyez sur le bouton [ +, -] pour sélectionner
<FM Search Level> (Niveau de recherche FM), puis
appuyez sur le bouton [ ® USER/e® MENU].

m Le menu FM Search Level (Niveau de recherche FM)
apparait.

5 Appuyez sur le bouton [ +, -] pour sélectionner le
niveau de recherche, puis appuyez sur le bouton
[® USER/@® MENU].
m Vous pouvez choisir entre <High> (Elevé), <Middle>
(Moyen) ou <Low> (Bas).

m Plus le niveau de recherche FM est élevé, plus le nombre
de fréquences regues est important.



| Réglage de I'affichage RDS

Le systeme RDS permet la réception et I'affichage de messages
tels que les informations de diffusion. Les informations de

o PTY programme tels que informations, sport ou musique ou encore les
détails de la station émettrice sont affichées sur I'écran.

1 Appuyez longuement sur le bouton
[® USER/@® MENU] pour accéder a I'écran de menu.

2 Appuyez sur le bouton [ +, -] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[® USER/ @ MENU].
= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner

<FM Radio> (Radio FM), puis appuyez sur le bouton
[® USER/ @ MENU].
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= Le menu FM Radio (Radio FM) apparait. g~
4 Appuyez sur latouche [ +, -] pour sélectionner 3
<RDS Display> (Affichage RDS), puis appuyez sur le g
bouton [® USER/e® MENU]. @
= Le menu RDS Display (Affichage RDS) apparait. 2
P @
= Sile signal F est e, 5 Appuyez sur la touche [ +, -] pour sélectionner le g._
FImE  linformation RDS peut ne mode RDS Display (Affichage RDS), puis appuyez sur -r|
pas étre affichée. le bouton [ ® USER/@® MENU]. =
m Vous disposez d'une palette d'options comprises entre <PS> et <PTY>.
m <PS> (Service programme): affiche le nom de la station émettrice et se compose de 8 caracteres.
Si l'information PS est regue, le nom PS (BBC, AFO, NDR, etc.) est affiché sur I'écran.
Si linformation PS n'est pas regue, la fréquence FM originale est affichée.
m <PTY> (Type de programme): affiche le type de programme émis. e



Réglages
Réglage de la musique.
Réglage de I'heure .......
Réglage de I'affichage ..
Réglage de la langue
Réglage du systéme




Réglages

A H Vous pouvez définir des réglages détaillés pour la
Reg I ag e d e | a m u S I q u e lecture de données musicales.

1 Appuyez longuement sur le bouton [ ® USER/ @® MENU]
pour accéder a I’écran de menu.

= User EQ Set >y

2 Appuyez sur le bouton [ +, -] pour sélectionner
<Settings> (Réglages), puis appuyez sur le bouton
[® USER/ @® MENU].
= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner
<Music> (Musique), puis appuyez sur le bouton
[® USER/ @ MENU].

= Le menu Music (Musique) apparait.
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4 utilisez les boutons [ +, - ] et [@ USER/ @ MENU]
pour définir les fonctions nécessaires.

. m Fonctions des boutons a utiliser pendant le réglage :

piros - Appuyez sur le bouton [ 4<«] pour aller a I'élément précédent.
- Appuyez sur le bouton [P»I] pour aller & I'élément suivant.
- Appuyez sur le bouton [+, -] pour vous déplacer vers le haut ou vers le bas dans le menu actuel.
- Appuyez sur le bouton [ ® USER/ e MENU] pour sélectionner ou enregistrer le menu.

anbisnw e| ap abe|bay

m Si aucun bouton n'est actionné sur I'écran Settings (Réglages) pendant environ 30 secondes, les
réglages sont annulés et reviennent a ceux définis a l'aide de la fonction précédente.
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Réglages

Réglage de la musique (suite)

DNSe : vous permet de sélectionner I'effet sonore adapté au genre musical. Options disponibles :
<3D-User> (Personnalisé-3D) <3D-Studio> (Studio-3D) <3D-Stage> (Plateau-3D) <3D-Club> (Club-3D)
<Normal> (Normal) <Rock> (Rock) <House> (House) <Jazz> (Jazz), <Dance> (Dance) <Ballad>
(Ballade) <R&B> (R&B) <Classical> (Classique) ou <User EQ (Egaliseur personnalisé).

Réglage 3D User (Personnalisé 3D) : permet de régler I'effet sonore 3D et le renforcement des
basses. L'effet 3D peut étre réglé entre 00 et 05 et le renforcement des basses entre 00 et 03.
Pour utiliser cette fonction, sélectionner <3D-User> (Personnalisé-3D) dans le menu <DNSe>.

Réglage User EQ (Egaliseur personnalisé) : permet de sélectionner directement un effet sonore
(EQ). Pour utiliser cette fonction, sélectionnez <User EQ> (Egalisateur personnalisé) dans le menu
<DNSe> (DNSe).

Play Mode (Mode de lecture) : permet de sélectionner le mode de lecture tel que les paramétres
de répétition. Options disponibles : <Normal> (Normal) <Repeat One> (Répéter un) <Repeat All>
(Répéter tout) <Shuffle All> (Lecture aléatoire de la totalité) et <Intro> (Intro).

Play Speed (Vitesse de lecture) : permet de réglez la vitesse de lecture de I'enregistrement
musical/vocal. Options disponibles : <x0.7> <x0.8> <x0.9> <x1.0> <x1.1> <x1.2> ou <x1.3>
(plus le nombre est élevé, plus la vitesse de lecture sera rapide).

Skip Interval (Intervalle de saut) : permet de régler l'intervalle lorsque vous appuyez sur le bouton
[ |4«] ou [»>P] pendant la lecture. Options disponibles : <1 Track> (1 plage) <03 Sec> (3 s)
<05 Sec> (5 s) <07 Sec> (7 s) <10 Sec> (10 s) <30 Sec > (30 s) ou <01 Min> (1 min).

Search Speed (Vitesse de recherche) : permet de régler la vitesse de recherche lorsque vous
appuyez sur le bouton [ |<4«] ou [»PI] pendant la lecture. Options disponibles : <01 Sec> (1 s)
<03 Sec> (3 s) <05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <20 Sec> (20 s) <30 Sec > (30 s)
ou <01 Min> (1 min).

Intro Time (Durée de l'intro) : Lorsque vous sélectionnez la fonction Intro (Intro) dans <Play Mode>
(Mode de lecture), le début de tous les fichiers est lu pendant le nombre de secondes que vous avez
définies. Options disponibles : <10 Sec> (10 s) <20 Sec> (20 s) <30 Sec > (30 s) ou <60 Sec> (60 s).

m Pour les fichiers VBR ou Ogg, l'intervalle de saut et la vitesse de recherche peuvent ne pas étre exacts.

REVARQE w Qu'est-ce que le DNSe ?

Le DNSe est un effet sonore des lecteurs MP3 développé par Samsung. Il se compose des modes 3D
(3D). Le mode 3D (3D) permet d'ajouter un effet stéréophonique a la musique.




Réglages

Réglage de I'heure

= Time Set > 1

= Auto Power Off >Y

Vous pouvez régler les fonctions liées au minuteur d'arrét
et a l'arrét automatique.

Appuyez longuement sur le bouton [ ® USER/ @ MENU]
pour accéder a I'écran de menu.

2 Appuyez sur le bouton [ +, -] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [ ® USER/ @ MENU].
» Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, - ] pour sélectionner <Time>

(Heure), puis appuyez sur le bouton [ ® USER/ e MENU].
m Le menu Time (Heure) apparait.

4 Utilisez les boutons [ +, -] et [® USER/ @ MENU]

pour définir les fonctions nécessaires.

n <Time Set> (Réglage de I'neure actuelle) : cette fonction vous permet de régler la date et I'heure actuelles.

n <Sleep> (Mise en veille automatique) : permet d'éteindre automatiquement I'appareil apres I'écoulement de la
durée préréglée. Options disponibles : <Off> (Désactivé) <15 Min> (15 min) <30 Min> (30 min) <60 Min> (60 min)

<90 Min> (90 min) ou <120 Min> (120 min).

n <Auto Power Off> (Heure d'arrét automatique) : permet d'éteindre automatiquement I'appareil lorsque aucun
bouton n'est actionné avant I'écoulement de la durée préréglée en mode Pause (Pause). Options disponibles : <Off>
(Désactivé) <05 Sec> (5 s) <10 Sec> (10 s) <15 Sec> (15 s) <30 Sec> (30 s) <01 Min> (1 min) ou <03 Min> (03 min).

Réglage de I'heure actuelle

EXR/02 /04
10 : 09 AM
(oo)

Appuyez sur le bouton [ [<4«] ou [»PI] pour atteindre
I'emplacement de votre choix, puis appuyez sur le
bouton [ +, -] pour régler la date et I'heure.

Une fois le réglage terminé, allez sur <OK> et
appuyez sur le bouton [® USER/e® MENU] button.

n Le réglage de I'heure actuelle est terminé.
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Réglages
Vous pouvez régler les fonctions liées au défilement,

Rég | ag e d e I 'affl C h ag e au rétroéclairage et aux autres affichages a I'écran.

= Scroll Speed >H 1 Appuyez longuement sur le bouton [ ® USER/ @ MENU]
= Backlight Time pour accéder a I'’écran de menu.

= Contrast >4 2 Appuyez sur le bouton [ +, -] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ ® USER/ @ MENU] .

» Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner
<Display> (Affichage), puis appuyez sur le bouton
[ ® USER/ @ MENU].

» Le menu Display (Affichage) apparait.

4 Utilisez les boutons [ +, -] et [® USER/ @ MENU]
pour définir les fonctions nécessaires.

m <Scroll Speed> (Faire défiler) : permet de régler la vitesse de défilement du titre de la plage.
Options disponibles : <Slow> (Lent), <Normal> (Normal) et <Fast> (Rapide).

m <Backlight Time> (Rétroéclairage) : permet d'arréter automatiquement I'appareil lorsque aucun
bouton n'est actionné durant la période préréglée. Options disponibles : <05 Sec> (5 s), <15 Sec>
(15 s), <30 Sec> (30 s), <60 Sec> (60 s) ou <Always On> (Toujours activé).

m <Contrast> (Contraste) : permet de régler la luminosité de I'écran d'affichage. Options disponibles :
valeurs comprises entre 00 et 10.

m <Tag> (Etiquette) : permet d'afficher les informations concernant les plages des fichiers musicaux
gréace & l'étiquette ID3. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

n <Display Time> (Durée a I’écran) : permet de contrdler la durée pendant la lecture de la musique.
Sélectionnez <Play Time> (Durée de lecture), <Remain Time> (Durée restante) ou <Total Time>
(Durée totale).

» <Screen Saver Term> (Economiseur d'écran) : Vous pouvez régler l'affichage de I'horloge a
I'écran puis sa disparition lorsque aucun bouton n'est actionné durant la période préréglée.
Sélectionnez <Off> (Désactivé) <05 Sec> (5s) <10 Sec> (10's) <30 Sec> (30 s) <01 Min> (1 min) <05 Min> (5 min)
<10 Min> (10 min) ou <Always On> (Toujours activeé).



Réglages
Permet de définir la langue du menu et des informations concernant

Réglage de la langue e Giauete 03,

= Menu > 1 Appuyez longuement sur le bouton [ ® USER/ @ MENU]
pour accéder a I'écran de menu.

2 Appuyez sur le bouton [ +, -] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [ ® USER/ @ MENU].
= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner
<Language> (Langue), puis appuyez sur le bouton
[® USER/ @ MENU].

= Le menu Language (Langue) apparait.

4 Utilisez les boutons [ +, -] et [® USER/ @ MENU]
pour définir les fonctions nécessaires.
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m <Menu>(Menu) : permet de régler la langue du menu. Options disponibles : <Chinese(S)>
<Chinese(T)> <Dutch> <English> <French> <German> <Hungarian> <lItalian> <Japanese>,
<Korean> <Polish> <Portuguese> <Russian> <Spanish> et <Swedish>.

» <ID3-Tag> (Etiquette ID3) : permet de régler la langue des informations concernant la plage. EE Qi
Options disponibles : <Afrikaans> <Basque> <Catalan> <Chinese(S)> <Chinese(T)> <Czech> QQ
<Danish> <Dutch> <English> <Estonian> <Finnish> <French> <German> <Greek> <Hrvatski> 8 g
<Hungarian> <Icelandic> <Italian> <Japanese> <Korean> <Norwegian> <Polish> <Portuguese> @ @
<Romany> <Russian> <Slovak> <Slovene> <Spanish> <Swedish> <Thai> <Turkish> et % %
<Vietnamese>. — =

b
o =
m Les langues prises en charge peuvent étre modifiées ou ajoutées. g g
m Qu'est-ce que I'étiquette ID3 ? % 8
Il s'agit d'un élément attaché a un fichier MP3 contenant les informations relatives au fichier telles que @

le titre, l'artiste, I'album, I'année, le genre et un champ commentaire.
51



Réglages

A A Vous pouvez régler les fonctions Default Volume (Volume par
Reg | age d u SySteme défaut), Resume (Reprise) et Beep Sound (Signal sonore).

1 Appuyez longuement sur le bouton [ @ USER/ @ MENU]

" elete File pour accéder a I'écran de menu.
" Resume >

Appuyez sur le bouton [ +, - ] pour sélectionner <Settings>
= Beep >U 2 ppuy [+.,-]p g

(Réglages), puis appuyez sur le bouton [ ® USER/ @ MENU].
» Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ +, -] pour sélectionner <System> (Systéme),
puis appuyez sur le bouton [ ® USER/ @ MENU].
n Le menu System (Systeme) apparait.

4 Utilisez les boutons [ +, -] et [® USER/ @ MENU]
pour définir les fonctions nécessaires.

n <Delete File> (Supprimer) : permet de rechercher et de supprimer les fichiers sur I'écran Navigation
(Navigation). » Page 53

» <Resume> (Reprise) : permet de spécifier le point de reprise de la lecture lorsque vous avez
interrompu la plage musicale en cours de lecture. Si <Off> (Désactivé) est sélectionné, la lecture
reprend au début du dernier fichier écouté. Si <On (Activé)> est sélectionné, la lecture reprend a
I'endroit ou elle a été interrompue.

m <Beep> (Signal sonore) : permet d'activer ou de désactiver I'émission d'un signal sonore lors
du fonctionnement d'un bouton. Options disponibles : <On> (Activé) ou <Off> (Désactivé).

u <Default VoI> (Vol. par défaut) : le volume par défaut peut étre réglé sur une valeur comprise
entre 00 et 30 (maxi.). Si 'appareil est remis sous tension une fois que le volume a été réglé
au-dessus de la valeur par défaut, la lecture s'effectue en fonction du volume par défaut.

Si I'appareil est remis sous tension une fois que le volume a été réglé dans la plage par défaut,
la lecture s'effectue en fonction du volume préalablement utilisé.

m <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut. » Page 53

= <About> (A propos de) : permet de contréler les informations suivantes : la version du micrologiciel, le
nombre de fichiers enregistrés et la mémoire restante.

m A propos de la mémoire intégrée

RENARQE  La taille de la mémoire intégrée réelle disponible est légérement inférieure a celle indiquée, car le
micrologiciel interne en utilise une partie.




Pour supprimer un fichier

= Delete File

Réglages par défaut

= Default Vol >
= Default Set

Appuyez sur le bouton [ |4«] pour aller au dossier
précédent.

Appuyez sur le bouton [ +, -] pour sélectionner le
dossier de votre choix.

Utilisez le bouton [»P] pour accéder a la liste des
fichiers du dossier sélectionné.

u Utilisez le bouton [»P] pour accéder au niveau inférieur
et le bouton [ I44] pour accéder au niveau supérieur.

Appuyez sur le bouton [ +, -] pour sélectionner un fichier
supprimer, puis appuyez sur le bouton [ ® USER/ @ MENU].

Appuyez sur le bouton [ +, - ] pour sélectionner <Confirm>
(Confirmer), puis appuyez sur le bouton [ ® USER/ @ MENU].

n Le fichier sélectionné est supprimé.

m Les fichiers ne peuvent pas étre récupérés une fois supprimés.

ATTENTION Soyez sir de vouloir les supprimer avant d'effectuer I'opération.

Appuyez sur le bouton [ +, -] pour sélectionner <Yes> (Oui) ou
<No> (Non), puis appuyez sur le bouton [ ® USER/«® MENU].
= <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.

= <No> (Non) : permet d'annuler les réglages par défaut.
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tialisation du systéme
nnage




Si un dysfonctionnement de I'appareil survient,

Rél n Itl al ISatI 0 n d u SyStém e vous pouvez réinitialiser le systeme en appuyant

sur le trou de réinitialisation.

Trou de réinitialisation —f

(@]
=
D
=3
=
=
@
(&
O
D
B
=]
8
@D

Appuyez sur le trou de réinitialisation situé sur la partie inférieure de |'appareil en vous

aidant d'un objet pointu (ex. : agrafe). oD
u Le systéme est réinitialisé. ‘C% =
= La fonction Reset (Réinitialisation) ne permet pas de supprimer les données enregistrées dans CBD f_,'
la mémoire intégrée. g'
g.
=S

o
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D é an n a e Si un dysfonctionnement survient, vérifiez les points suivants.
p g Sile probleme persiste, contactez le centre de dépannage Samsung le plus proche.

L'appareil ne s'allume
pas.

Les boutons ne
fonctionnent pas.

L'écran ne s'allume pas.

L'alimentation est coupée.

La durée de vie de la
batterie différe de celle
spécifiée dans le manuel.

» L'appareil ne s'allume pas si la batterie est entierement
déchargée. Rechargez la batterie et remettez |'appareil sous
tension.

» Appuyez sur le trou de réinitialisation.

n Vérifiez si l'interrupteur [HOLD] est dirigé dans le sens de la
fleche.

m Vérifiez que vous avez appuyé sur le bouton adéquat, puis
essayez a nouveau.

m Appuyez sur le trou de réinitialisation.

» Si vous avez sélectionné <Backlight Time> (Rétroéclairage)
dans le menu <Settings> (Réglages) —* <Display>
(Affichage), I'écran est peut-étre éteint. Appuyez sur
n'importe quel bouton pour rallumer I'écran.

n |l se peut que les données affichées a I'écran ne soient pas
visibles sous les rayons directs du soleil.

L'alimentation se coupe automatiquement lorsque la batterie
est entierement déchargée. Rechargez la batterie.

= La durée de vie de la batterie varie en fonction du réglage des
fonctions EQ (Egaliseur) et LCD (LCD).

m La durée de vie de I'appareil peut étre réduite si vous
I'exposez a des températures basses ou élevées pendant
des périodes prolongées.



La lecture est
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des don-
nées manquent.

Affichage anormal de la
durée de lecture.

Affichage anormal du
nom de fichier.

n Vérifiez que le fichier disponible a bien été enregistré dans la
mémoire.

m Assurez-vous que le fichier musical n’est pas endommagé.

» Vérifiez que la puissance de la batterie est suffisante.

n Vérifiez que la cable USB est correctement branchée, puis
rebranchez-la.

n Vérifiez que la mémoire est pleine.

» Appuyez sur le trou de réinitialisation.

Vérifiez que la cable USB n'a pas été débranchée durant le
transfert des fichiers ou des données. Si tel est le cas, les
fichiers/données et méme I'appareil risquent d'étre
endommagés. Vous devez faire preuve d'une grande prudence
car Samsung ne peut en aucun cas étre tenu responsable de
la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Allez dans <Settings> (Parametres) — <Language> (Langue) —
<ID3-Tag> (Etiquette ID3) dans I'écran de menu et sélectionnez la
langue appropriée.
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Dépannage (suite)

Dysfonctionnement du
programme.

La connexion a
I'ordinateur est
désactivée.

Le rétroéclairage ne
s'allume pas.

L'appareil est chaud.

58

Veérifiez que la configuration requise de I'ordinateur a été
correctement établie.

» (Sous Windows 98SE) Vérifiez que le pilote USB est installé
et procédez a l'installation s'il ne I'est pas.

= (Sous Windows ME/2000/XP) Cliquez sur le menu Démarrer
du bureau et lancez la mise a jour Windows. Sélectionnez
les derniéres mises a jour critiques et I'ensemble des
modifications provisoires, puis lancez la mise a jour.
Redémarrez votre ordinateur et rebranchez le lecteur.

n Contrélez la durée du rétroéclairage.
n Vérifiez la batterie.

Les phases de chargement peuvent générer de la chaleur.
Cela n'a aucune incidence sur la durée de vie de |'appareil ou
sur son fonctionnement.



Installation
Spécifications du produit........ccc.ccc........



A [ b orescence d €S MEeNUS Cette fonction vous permet d'obtenir un

Ecran de sélection du menu

apercu rapide de la structure des menus.

Music Navigation Playlist Settings
[ | | I I 1

Music User Button Mode Time Display Language System

DNSe Navigation Time Set Scroll Speed Menu Delete File
3D User Set Repeat AB Sleep Backlight Time ID3-Tag Resume
User EQ Set DNSe Auto Power Off Contrast Beep
Play Mode Play Speed Tag Default Vol
Play Speed Play Mode Display Time Default Set
Skip Interval Screen Saver Term About

Search Speed

Intro Time
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Installation manuelle du pilote USB

Installez le pilote USB manuellement lorsque l'installation automatique n'est pas possible ou
lorsqu'une erreur s'est produite lors de ['installation.

n Insérez le CD d'installation dans le lecteur de CD-ROM de l'ordinateur.

| Si une erreur se produit lors de l'installation du pilote USB

1 Vérifiez le gestionnaire de périphériques. [& wmummwe =
Windows 98SE/ME : Panneau de EECR-LR- R e L ‘
configuration— Systeme— Gestionnaire :
de périphériques
Windows 2000/XP : Panneau de
configuration— Systéme— Matériel—
Gestionnaire de périphériques

Q
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2 Vérifiez si un périphérique comportant
un point d'exclamation ou d'interrogation
figure dans la liste (affiché comme
périphérique inconnu ou périphérique USB).

3 Double-cliquez sur le périphérique comportant un point d'exclamation
ou d'interrogation.

m Si vous utilisez Windows 2000 et que votre version de Windows ne reconnait pas le pilote USB, veuillez
télécharger et installer la derniere version de I'ensemble des modifications provisoires & partir du site
windowsupdate.microsoft.com

/Snusw Sap aduadsal0qly

m La méthode d'installation peut varier en fonction du type d'ordinateur ou du systeme d'exploitation.
Contactez votre vendeur d'ordinateur ou votre centre de services pour obtenir des informations sur
linstallation.

gsn a10)id np ajjanueWw UoNe|EISy|

m Si des erreurs se produisent de maniére répétée apres linstallation du pilote USB, rebranchez la cable
USB apres le redémarrage de votre systéme. 61
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Installation manuelle du pilote USB (suite)

4 Une fois le pilote sélectionné,

5 Cliquez sur [NEXT] (SUIVANT).
cliquez sur [Reinstall Driver]
(Réinstaller le pilote).
e P 5

Genrol | e | Welcome to the Upgrade Device
Driver Wizard

@ USB Devic

Device type: Other devices

""1 Réinsfall Driver I

Devoe usage
I~ sl i hevdios S
R Eits i of hadware proles

o] _eme |

6 Sélectionnez [Search for a suitable 7 Cliquez sur [NEXT] (SUIVANT) pour
driver for my device] (Rechercher un terminer.
pilote adapté a mon périphérique),
puis cliquez sur [Next] (Suivant).

This wizad searches fo new divers fr

USB Device:

& davice diver s  soltware progiam that makes 3
hadware device work.




| Sous Windows 98SE

Suivez les instructions qui s'affichent a I'écran pour terminer linstallation.

‘Add New Hardware Wizard

This wizard seaiches for rew divrs for

(R )
A device diiver is a soltware progiam that maskes &
§Y hadware deves wotk.

(Add New Hardware Wizard

What do you want Windows to do?

 {Besich o the best v for yout device. |
{Rezommended)

€ Display alistof sl he divers in a specific
location, s0 you can selectthe diver you want

1=

Uidons e o G s divor e
onyour had dive,

e Gk ok s

I Elppy sk dives

I~ CcoROM dive

I MictosotWindows Updte

7 Specil  jocacn:

Samaung TxUsB

Locaton o dives

Wi dive i search o the dvice:

indows s now ey o ntl e best dive o s
device ik Back o seect a ifren diver, of cick Next

5 CAWINDOWSANFMUSBAZ N

‘Add New Hardware Wizard

Diver

Samsung T+ USE Diver

‘Windows s frished ndaling th sotvare thatyout rew
Patdvae devie equies.

=]

=

o |
I

Emplacement du pilote USB
[CD-ROM] \USB Driver\win98 USB

Vous devez redémarrer votre ordinateur pour terminer l'installation.

m Vous pouvez |'utiliser comme disque amovible sous Windows 98SE si le programme Lecteur n'est pas
installé. Veillez a installer le fichier du pilote USB en premier.

(@]
=
)
k=]
=3
=
@
&y
>
=]
=
@
X
@
7]

| & ggn ajo)d np sfjenuRW UONE|ERISU|



Spécifications du produit

Nom du modéle YP-F2R
Alimentation 3,7 V (Lithium-polymére rechargeable)
Alimentation de la batterie intégrée|  250mAh

Fichier |Compatibilité

MPEG1/2/2.5 Couche 3 (8 kbps a 320 kbps, 8 kHz a 48 kHz)
WMA, ASF (48 kbps & 192 kbps,8 kHz & 48 kHz), Ogg (Q0 & Q9)

Nombre de dossiers et fichiers supportés|

Dossiers : Max. 2000 Fichiers : Max. 200

Sortie des écouteurs

20mW(France 5mW/CH)(16Q)

Bande de fréquences de la sortie

20Hz~20KHz

Taux de bruit

90 dB avec filtre passe-bas de 20 KHz (sur la base de 1 KHz, 0 dB)

Durée de lecture

12 heures de lecture musicale (MP3 128 kbps, volume 20, Normal mode sonore)

Plage de température pour e fonctonnement|

-5a35°C

Etui

Plastique

Poids

2059

Dimensions (L x H x P)

28,1 x52,5x 15,5 mm

Fréquence FM 87,5~108,0MHz
Rapport signal FM 55dB
THD.FM 1%
Sensibilité FM utile 10dBu

@ Le contenu de ce manuel est susceptible d'étre modifié en vue d’étre amélioré sans
notification préalable.



L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée a une
utilisation privée non commerciale par I'utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a un
produit ou processus qui n'est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniqguement l'utilisation de ce produit pour encoder et/ou décoder

des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions

du produit qui ne sont pas conformes & la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
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Ce symbole sur le produit ou sa documentation indique qu'il ne doit pas étre
éliminé en fin de vie avec les autres déchets ménagers. L'élimination
incontrdlée des déchets pouvant porter préjudice a I'environnement ou a la
santé humaine, veuillez le séparer des autres types de déchets et le recycler
de fagon responsable.

Vous favoriserez ainsi la réutilisation durable des ressources matérielles.

Les particuliers sont invités a contacter le distributeur leur ayant vendu le
produit ou a se renseigner aupres de leur mairie pour savoir ou et comment ils
peuvent se débarrasser de ce produit afin qu'il soit recyclé en respectant
I'environnement.

Les entreprises sont invitées & contacter leurs fournisseurs et a consulter les
conditions de leur contrat de vente. Ce produit ne doit pas étre éliminé avec les
autres déchets commerciaux.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.
Samsung Service Consommateurs
08 25 08 65 65 (€ 0,15/min)
www.samsung.com/fr
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